37 Interesting Ways* to use
Google Docs in the
Classroom
(*and Tips)
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#1 - Use Spreadsheets for a first
collaboration session.
● For the first session with
your class on sharing
and collaborating use a
spreadsheet.
● There is a limit of 50
simultaneous
collaborators so there is
plenty of room for a
whole class.
● In this way you can
include everyone and
prove the concept of a
shared workspace and
live updating.

50

#2 - Share pulse rate data
● Use a single shared spreadsheet
for the whole class.
● Add the children's names in the
first few rows.
● Add Pulse Rate 1, Pulse Rate 2 ...
along the column headings.
● When exploring resting pulse rate
or pulse rate change ask the
whole class to add their data at
the same time.
● Pooled data could then be analysed, averaged, charted and
explored.
● The sharing of data from peers helps children to think about
the accuracy and reliability of science data and to deal with
a larger data set quickly.

#3 - Know your limits
● There are limits on the number of synchronous
collaborators for each Doc type.
○ 10 people can edit a Presentation at the same time (in
old versions of Google Docs).
○ 50 people can edit a Spreadsheet simultaneously.
○ 50 people can edit a Document at the same time.
●
● There is a limit of 200 combined viewers/ collaborators for
all of the different Doc types.
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#4 - Use a Table in a Document to
facilitate collaboration
● Unlike Spreadsheets with cells and
Presentations with pages,
Documents are an open space,
and can sometimes exacerbate
communication problems when
collaborating.
● Consider using a TABLE when you
are working in large numbers in a
Document.
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● Add structure to the page by adding a TABLE or if that does
not suit the work, simple headings to signpost where people
are working.
● This structure helps younger children to collaborate.

#5 - I am Unique!
● This is a good activity to model
the use of a shared space and
live editing, as well as learning
about a new class.
● It can be done in any of the Doc
types.
● Ask your class to individually work
on a single shared Document and
finish the sentence: "I am Unique
because..."
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● They can add 3 different answers.
● Not only will you learn about your children but as it is shared
they will learn about each other.

#6 - Document Stats
● From the Tools menu, choose Word Count
Includes statistics about the document including the
Automated Readability Index. It's a great motivator for
students to have them write to their grade level. Gives
students the ablity to review the work and improve word
choice, sentence structure and other key elements in their
document.
More on readablity:
http://plainlanguage.com/newreadability.html

#7 - Add a Footnote
● From the Insert menu, choose
Footnotes
Great lead in to teach about
copyright, plagiarism, and cyberethics in general. Document will
include a # at the location of the
inserted footnote with information in
the sidebar. When printed, it is
located at the end of the document
for proper documentation.
More on Google Footnotes:
http://is.gd/4V0u

#8 - Collaborative Homework
The collective working abilities of
google docs are incredibly useful for
collaborative homework.
For example several students can
work on their presentation to be
delivered during the hand-in lesson.
An alternative use is to collaborate on
environmental / experimental data
allowing access to group results and
data.

#9 - Publish a presentation for protected
sharing.
● Instead of sharing a presentation in the
normal way, allow students to view the
published version.
● In this way it remains protected and
edits are closed.
● Your students will get a better look at
the presentation.
● You can retain control over what they
see and when.
● Just email or share the presentation
URL from the top right of the
presentation screen.
An alternative would be to invite "Viewers"
instead of "Collaborators".

#10 - Use the Backchannel!
● Whilst presenting, encourage the
class to respond to verbal
questions in the chat window of
the presentation.
● Better still have questions
prepared on the slides for them
to respond to.
● I have found that Year 5 (9-10
years old) children are engaged
and motivated by using this
instant messaging in a structured
form in lessons.

Google chat feature in GPres

● We have also had success when students are reviewing other
children's presentations and adding feedback in the chat window.

#12 - Use Templates
Google has created templates for students and teachers.
● Teachers can direct students to use a certain template or
they can browse the different categories.
● Teachers can also create their own templates and share
them with their students.
● Make sure students save the template as a copy.

Screencast on using templates with students
Middle School Lab Rep
ort Template

#13 - Collaborate prior to a field trip
The Big Zoo Trip - by Westpark and Stanley Elementary First

Graders
Sara (Kansas City Zoo)

Kaylee (Cleveland Zoo)

The gorilla is gray and black.

The gorilla is all black.

Bob likes to eat vegetables.

Mac likes to eat vegetables.

He plays on rocks and gorilla
toys.

He likes to play with the other
gorillas.

He has lots of friends, but no
baby.

He also has a baby.

Cindy Lane, GCT http://www.xrl.us/clane

#14 - Get Organized or just Search!
Encourage the children in your class to create subject folders
from the NEW menu as they begin to create more documents.
These folders can be labelled with different colours to help
show where documents belong.
Encourage them to also use
SEARCH to quickly find
what they are looking for. I
find this one of the quickest
ways to find content.
Advanced searches are also
an option.

#15 - Share revision lists with pupils
Use Google Spreadsheets to share a revision list/log with your
pupils.
Put pupil names along the top, topics down the side and a set
of cells in-between with Red Amber Green conditional
formatting (right click and choose 'Change colours with rules').
Encourage pupils to
update the sheet
throughout their
revision.
Use the list to plan your
final revision lessons.
Feel free to copy this example: http://bit.ly/mrET1

#16 - Buddy Edit
Use Google Docs for students to buddy edit their
Information Reports (or other type of writing).
They simply need to share their document with their
writing buddies.
If you include the teacher as a collaborator and they
can assist in the process as well, long before the
product is finished.

http://leighnewton.edublogs.
org/

#17 - Reading Response
I've been finding it difficult for students to
engage with me in their Reading Response
Journals.
I leave questions for them which are mostly
ignored.
By requesting them to use Google Docs for the
Reading Response there can be an ongoing
conversation, aided by the extra motivation of
working online.
http://leighnewton.edublogs.
org/

#18 - Assessment-4-Learning: GForms
Set-up google form to create a
spreadsheet for pupils to enter
feedback on how they felt they
coped with the lesson/learning
objective.
Enter forename and surname
initial and class to maintain
relative anonymity.
Grade understanding from 1 to 5
or ABC.
Option to enter a comment.
Embed the form in VLE for easy
access.
(enlarge images to see detail)

#19 - Student feedback jank
● Started to use Google
Spreadsheet to
feedback to students
about their coursework
and help them set targets.
● They have responded
really well to these short
term targets which they
see updated in real time.
● A great motivational tool
and effective feedback
system.
● At present it is a task
checklist but looking to
incorporate assessment
feedback.

@infernaldepart

#20 - Create Dynamic Visualizations
● Enter your data set into
a Google Spreadsheet.
● Then use Exhibit to
create websites with
advanced text search
and filtering functions.

● Good for interactive maps &
timelines.
● Great for integrated projects
involving spreadsheet,
database & web design.
@pdonaghy

#21 - Collect Website Evaluations
● Ask your children to
find a website on a
particular topic and
to then evaluate it by
answering the
questions on a
GDocs form.
● Collected
evaluations can then
lead to discussions
about how websites
have different
audiences and how
some are more
useful/helpful than
others.

View
Example `
`

@simonhaughton

#22 - Spreadsheet Magic Fill

#23 - Conduct a Tech Use 'Google Forms' Survey
Instead of reading about the
rest of the world's data on how
students use technology, why
not gather your own?
Using Google Forms, survey
your students about the types
of devices they have in their
homes, how often they use
them, and which social
networks they belong to.
The results may surprise you,
and provide you with real data
to 'enlighten' your colleagues
as to how much technology is
being utilised by your students

Contributed by @adambrice

#24 - Use Google Forms as an
electronic tear off reply slip
Students are often the weak
link when returning slips.
When running a parents
information evening we
offered an electronic
alternative to replying on
paper. We also embedded
the form on our VLE.
Entries go straight to an
unshared spreadsheet .

The form is still at bit.
ly/JBSMathsEvening
@chris_1974

#25 - Assignment Tracker
Whenever a student completes a digital assignment they visit a Google form I've
created that asks for their name, class period, and assignment name. I also ask
them to paste in the link to their completed assignment.
I view the spreadsheet each day and grade each assignment turned in. I use a
color-coding system to provide quick feedback to the students. The spreadsheet
is published as a webpage - the outbox. A green row means that the assignment
was graded, an amber line indicates that the assignment was incomplete and I
type a short, but relevant message in the adjacent cell. If the row is highlighted
in red, the link given was incorrect.
Students and parents have access to the otherwise private spreadsheet link
behind a password protected site. I keep the spreadsheet up for the entire
grading period so that parents and students can monitor assignments and it has
put an end to "I thought I turned that in" questions for me. I create a new inbox
for the following term.

John Miller

#26 - Error Correction
Prepare a document with
deliberate errors in it and
ask the students to make
corrections.
Works well with a whole
class correcting at the same
time in the lab or projected
onto a screen with individual
students taking turns.
Great for foreign language
classes.

@DaveDodgson

#27 - Collaborative writing from notes
Set a writing task for which students have to write something
from standard notes (e.g. a formal letter or a sequence of
pictures telling a story).
Once this is completed, ask students/groups one at a time to
contribute a sentence or two to a shared document to produce a
definitive class version.
Encourage editing of previous sentences, both for content and
errors.
Works with several computers or just one projected onto a
screen with students taking turns.
@DaveDodgson

#28 - Shared Professional Writing
Are you working with a student teacher
or coteacher?
Are you crafting new curriculum?
Writing your school improvement plan?
Collaboratively write lesson plans and
other documents in Google Docs in order
to share ideas and writing in real time as
well as provide timely feedback and
clarification to colleagues.
Photo credit: Teacher Pre-Planning, Old Shoe Woman, http://www.flickr.
com/photos/judybaxter/998250794/sizes/s/in/photostream/

@ckendall

#29 - Forms for Professional Development
If you are running PD for staff
within the school, use a Google
Form to collect info from the
teachers that you need. This
feeds into a spreadsheet which
you can set up to send you an
email each time an entry is
made. I set up an extra sheet on
the spreadsheet where I move
completed sessions as a record
of what has been covered.

Suzie Vesper
http://learningweb2.wikispaces.com

If you add it to your Google
Calendar, you can also embed
this so teachers can see what
timeslots have been taken
before booking. I like to embed
the agenda view.

#30 - Google Docs as Learning Portfolios
Have the students share a
document with the teacher at
the beginning of the school
year. Student name, class,
and assignment title, should
be included in the title.

@paulbmckenzie

Teacher drags these docs
to class folders. Instruct
students to add future
assignments to the top of
the page. Updated
assignments float to the
top of your class/subject
docs folders for easy
feedback/marking. Have
students publish and
embed docs in their blogs
or Google Sites. Teacher
comments do not appear
in the published version.

#31 - Butcher paper/brainstorming
Embed a GForm on a GSites
page, and embed the resulting
GSpreadsheet below it.
This can function a lot like a
wiki, or commenting on a blog,
but with a restricted
purpose/scope, and universal
access.
I have students go to a class
computer whenever we run
across a homophone to add it to
the class website.
Also good for adult
asynchronous brainstorming.
@senorw
https://sites.google.com/site/misterwarkentin

#32 - Easy Data Collection from Staff
Create a Google Spreadsheet for data collection from staff (Student
Council voting in homeroom, canned food drive collection count by
homeroom teachers, etc).
If working with staff that aren't familiar
with Google Docs or don't have a
Google account, set your
spreadsheet sharing settings to
"Anyone With The Link" and check
off "Allow anyone to edit (no sign-in
required"
After clicking SAVE, copy the link and
send to staff through email.
Staff can now enter data in the
spreadsheet without having to signin!
@chadkafka // www.chadkafka.com // Blog Post with Steps for this idea

#33 - Collaborative Textual Analysis
Upload a Word document with poetic text divided in to sections. Put pupils in
pairs and give them sections of the poem to work on. Different coloured fonts is
always a good idea! Only give them five minutes per section before "moving on"
to the next section!

@davidmiller_uk // TES English Panel // Independent Thinking

#34 - Parents consultation evenings
Simple form into which Parents can leave messages or queries whilst waiting to
see or speak with you. Useful if you get a queue forming but can also be shared
with parents who cannot make it on the night.

@4ict Richard Cook UK

#35 - Google Drawing for Brainstorming
Use shapes, arrows, images and text to create a visual map,
then let students work in groups to generate ideas. Use the
revision history to see individual contributions from students.
Consider creating templates to help students get started.

@soxnevad

Cool Tools for 21st Century Learners

#36 - Google Presentation to Build Vocabulary
Students work collaboratively in groups of 3 to construct
knowledge about vocabulary. Include a video, an image and a
definition written in students' own words. Duplicate the card
and use animation to create flash cards for review.

@soxnevad

Cool Tools for 21st Century Learners

#37 - Use Table of Contents in Doc to better
organize and find information
In order to not "lose" your students in a doc that is full of
information, create a table of contents that allow your students
to "jump" to the section they need to go to. This will also help
with managing the number of students you have using the doc
simultaneously too. :-)
Here is how to do this:
1. Go to the Format menu and select Paragraph styles to add headings to sections of your
document. There are six different heading sizes to choose from.
2. Place your cursor where you'd like to insert the table of contents.
3. Go to the Insert menu, and select Table of contents.
4. If you need to move the table of contents, select it as you would select text and either move it with
your cursor or cut it and paste it.
5. You can continue to add headings to your document or change current headings. However, if
you'd like a change to become part of the table of contents, you need to click first the table and
then the Refresh button.
Important: If you want to change the text of the table of contents, edit the headings in the document body rather than in the
table of contents. Once you update the table of contents by clicking the Refresh button, any manual edits you made in the
table of contents will be cleared.

@iTechSpec

If you would like to:
● Contribute your ideas and tips to the presentation.
● Let me know how you have used the resource.
● Get in touch.
You can email me or I am @tombarrett on Twitter
If you add a tip (or even
if you don't) please
tweet about it and the
link so more people can
contribute.
I have created a page for all
of the Interesting Ways
presentations on my blog.
The whole family in one
place :-)
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Thanks for helping
Tom Barrett
Have you seen Maths Maps yet?

